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models dw220, dw222, dw223, 
dw225 & dw226 

    Installation & Operation Manual 
for firmware version 0x2019

speedy
drive.web

Distributed Process Controller

speedy, savvy, savvyPanel, smarty, Bardac and drive.web are trade marks of Bardac 
Corporation, registered in the U.S. and other countries. 

®

®

®

®

CE 

Drives and Automation 
Call 800-848-2504 
www.emainc.net 



EMC Standard, EN 61326-1: 2006, Electrical Equipment for Measurement, Control and 
Laboratory Use.

	 Emissions Class A, Commercial Equipment.

	 Immunity Table 2, Industrial Equipment.

LVD Standards, EN 61010-1: 2010, Safety Requirements for Electrical Equipment for 
Measurement, Control and Laboratory Use and; 

	 EN 61010-2-030: Particular Requirements for Testing and Measuring Circuits.

speedy is an industrial controller designed for permanent installation by qualified professionals. 
If  it is used in a manner not specified herein the protection provided may be impaired.

speedy and its packaging contain recyclable materials.

This device is designed to comply with Part 15 of FCC Rules. Operation is subject to the following 
two conditions: (1)This device may not cause harmful interference, and (2)this device must 
accept any interference received, including interference that may cause undesired operation.

This Class [A] digital apparatus is designed to comply with Canadian ICES-003.  Cet appareil 
numerique de la classe [A] est conçu conformer à la norme NMB-003 du Canada.

Warning! It is essential that you read and understand this entire manual and the entire 
contents of the savvy software Help menu before proceeding with your installation and 
configuration. See page 9 for savvy installation instructions. For more information and to 
download manuals and software, go to www.driveweb.com or contact us. See page 24.

Warning! Your use of savvy software and drive.web devices may cause motors and 
machinery to power up with high Voltages or start or operate in an unexpected, dangerous or lethal 
way. It is essential that you are completely familiar with all of the equipment and the system design 
before attempting to program or edit a program or connect to any live device. It is also essential that 
a risk assessment is conducted to identify hazards. Risks must be reduced to tolerable levels.

Warning! You are entirely responsible for the configuration or use of any drive.web product. 
By configuring or using these products you agree to indemnify and hold harmless Bardac 
Corporation, its’ employees, directors, officers, distributors and resellers against the consequences of 
your configuration or use of  the products.

Warning! Information in this manual is subject to change without notice. You are responsible 
for verifying the proper operation of your speedy module. Special care must be taken after loading 
new firmware or installing new options.

Warning! Avoid permanent damage to your speedy, never exceed any min or max values.  
Do not connect any speedy terminal to mains circuits. See page 8 for IO ratings.
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This product is designed to conform to CE and UL standards:

lwIP is incorporated into speedy firmware. lwIP Copyright (c) 2001-2004 Swedish Institute of  Computer Science. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of  source code must retain the above copyright notice, this list of  conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution.
3. The name of  the author may not be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 

PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 

SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 

NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.



Product identification, speedy model number
speedy is  a range of programmable devices  using drive.web distributed 
control over Ethernet for industrial process  automation. To program and use 
a speedy you must get the savvy software tools from www.driveweb.com. 
Please see pages 9 to 12.
To find the speedy‘s  firmware version,  launch savvy,  choose Get Detailed 
Info from the speedy contextual menu. See pages 11, 12. 

dw220 generic ModbusRTU master up to 500kbps.

dw222 for ODE-2 variable frequency drive.

dw223 for ODP open-loop vector drive.

dw225 for YaskawaF7 inverter drive.

dw226 for HVAC variable-torque AC pump and fan drive.

Basic speedy standard features
drive.web distributed process control.
10/100Base-T(X) Ethernet, page 6
Field upgradeable firmware
Ultra-compact design may be permanently bonded inside equipment.
High-speed ModbusRTU on EIA485. Up to 500kb/s.
Drive-dedicated models can bus-share EIA485 network to control or 

monitor additional servers at different addresses. See page
E-Mail Notify block, outgoing SMTP mail server support, page 11.
Basic Control Function Block Library. See savvy User Manual for listing. 

speedy options 
Software options may be added using savvy. See page 13. See 
savvy User Manual, Appendix A for function block listings.
04 ModbusTCP/IP Slave/Server. See page 18.
05 Process Control. Function Block Library 1.
06 Winder Control. Function Block Library 2.  See page 19.
10 Advanced Math. Function Block Library 3. 
25 EIP/PCCC Slave/Server. See page 18.
26 savvyPanel Operator Station Interface. See pages 14 to 17.
29 Solar with Sun Position calculator.
50 DIN rail mount with terminal block wiring.

drive.web automation

speedy HG503206beta2  www.driveweb.com             Page 3/20



speedy Specials
Generic engineered solutions  include required options (in 
parentheses), system configuration and wiring  diagram. Contact us 
for many other engineered solutions. Options may be added. 

-1101 Open-loop Constant Tension Center Winder (05, 06)

-1102 Closed-loop Dancer Control Center Winder (05, 06)

-1103 Closed-loop Loadcell Control Center Winder (05, 06)

-1104 Slip Core Winder (05, 06)

speedy Installation
speedy is designed for permanent installation by qualified professionals.

Warning! Dangerous, High Voltages that may cause 
injury or death are present on drives,  motor controllers and 
other industrial devices! 
Only qualified personnel who are completely familiar with the 
system that the speedy will connect to should proceed!

Environment: UL/IEC Pollution Degree 2,  Operating 
temperature, 0°C min., 50°C max. Altitude 3000m max. Storage 
temp, -20°C to  60°C. Humidity 95%  max. non-condensing. Install 
in metal enclosure with no RF noise source

Dimensions & Clearances:

1” clearances must be provided on three long sides to promote airflow. 
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23mm
0.91”

36mm
1.42”

21mm
0.83”

48mm
1.42”

57mm
2.24”23mm

0.91”

Standard model with DIN rail mounting option



speedy Installation continued...

Weight: Standard-19g(0.7oz). w/ DIN rail & terminals - 28g(1.0oz)

Power requirements: Regulated 24VDC ±10%, 40mA.  Do not 
connect to a distributed DC power network.

Serial port EIA485(RS485) 0.1 to 500Kbps. Unisolated, power 
and serial circuits must have compatible common-mode Voltages.

Ethernet port MDI 8P8C, “RJ45”  jack, 100baseTX, 10BaseT, 
Full Duplex, Auto Negotiation, Auto-MDIX, IEEE 802.3ab. 

USB port  Peripheral-type Micro-B jack.

Ethernet LEDs For setup, troubleshooting and monitoring:

100 Green LED indicates 100BaseTX Ethernet connection.

Link / Activity Yellow LED. On for Link, flashing for activity.

Adhesive Mounting. Clean adhering surfaces  with alcohol first. 
Use caution,  bond is permanent. Adhere on or near the drive 
or EIA485 device.  Do not obstruct air vents,  access points  or 
product  labels.  Do not attach speedy near hot spots  such as 
heatsinks, cooling fans, etc., nor near to AC power lines.

DIN rail option. Use 35x7.5mm rail per IEC 60715, EN50022.

Terminal wiring: Strip 7mm(0.28”)  or use ferrules. Use 
0.2mm2 (AWG24) minimum. One wire, 2.5mm2 (AWG12) 
maximum.  Two wires,  1.5mm2(AWG14) maximum. Two 
wires with ferrules, 1mm2 (AWG18) maximum.

Terminal tightening torque: 0.5 Nm (4.4 in⋄lbs)

Signal wiring  notes. Use twisted-pair wiring. All wiring 
outside of the metal enclosure should be shielded cable with 
individually shielded twisted-pairs  such as  Belden 8163.  
Ground the shield at only one end with a 360° clamp where 
the shield enters  your metal enclosure. Separate all wiring 
from RF noise sources and AC power cabling. 
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speedy power and serial connections
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24V

0V, C

A

B

dw220 
standard 15”, 24AWG, 
solid-wire connections.

with DIN rail mount option.
Single, local device connections.

24V

0V, C

A

B

0V    24V

C

A

B

24V

0V

A

B

24V

0V, C

A

B

YF7 
terminal

Wire 
name

SP 24V

IG and SN 0V, C

S- and R- A

S+ and R+ B

with DIN rail option.
Single, local device connections.

24V

0V, C

A

B

dw225 
standard 15”, 24AWG, 
solid-wire connections.



speedy serial port connections continued...

Name EIA485 name Modbus name Description

A A or Data − D0 Inverting Pin

B B or Data + D1 Non-Inverting Pin

C SC or Data 0V Common Common Reference

A and B must share a single twisted-pair. C may use one or both 
conductors in another pair. Do NOT pair C with other signals.

EIA485 Common Reference is  required. It is  named C so that it is  not 
confused with other common, ground or shield connections.  

Correct multipoint topology is daisy-chain or trunk with device at each 
end and additional devices  on short stub branches. Star, ring, or 
extended branch topologies are NOT recommended.

Connect line termination between A and B at both physical ends  of a 
ModbusRTU network, typically 150Ω,  0.5W or for networks  with line 
polarization, 120Ω,  0.25W and 1nF, 10V cap in series. Do NOT provide 
line termination on any network with an Optidrive. 

Drive setup 
speedy 
model

Supported 
drive

Required drive settings Related drive 
settings

dw220 Generic Baud-rate, framing Serial loss behavior
dw222 OptidriveE2 P-36; Address = 1,

Baud rate= 115.2Kbps
P-36, Comms Loss Trip 

Enable

dw223 OptidrivePlus P2-26, Baudrate = 115.2Kbps
P2-27, Address = 1

P2-26, T, trip or R, 
ramp on serial loss

dw225 YaskawaF7 H5-01 = 1F, decimal 31
H5-02 = 4, 19.2Kbps
H5-03 = 00, No parity
H5-06 = 05, Min. delay 5ms

H5-04 Stopping Method
H5-05 Serial Fault 

Detect

dw226 OptidriveHVAC P-36; Address = 1,
Baud rate= 115.2Kbps

P-36, Comms Loss Trip 
Enable

dw223 Optidrive Plus Notes
Check drive model number and firmware version. P0-28 and 
P0-29 should indicate 2.2 or higher. Model number must end in -M for 
firmware versions prior to 3.0.
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Drive setup continued...

dw225 Yaskawa YF7 Notes
Check Flash ID, U1-14 = 3020. 
Check internal line termination switch S1-1.
You must cycle the YF7’s  power, waiting for the screen to 
blank,  before re-powering, in order for parameter changes 
to take effect.

speedy Ethernet Networking & Programming
Before proceeding, it is important to have a basic 
understanding  of Ethernet TCP/IP networks. Assigning an 
invalid or duplicate IP address will cause serious  network 
malfunctions! speedys are all shipped with the same IP 
address, 10.189.189.189. Consult your company’s  IT 
department for an appropriate, unique IP address.

Find useful networking  information. Under the Help menu 
click on User Manual. Scroll down to the Basic 
Network Administration section. 

Set up Your Physical Ethernet Network - You Will Need:
A standard Category 5e cable with 8P8C/RJ-45 

connectors on both ends for each drive.web  device and 
your computer.

For systems  with more than one drive.web device, an 
Ethernet switch with ports for all drive.web devices and 
your computer.

Set up Your Computer - Get savvy
With free drive.web savvy software,  easily program and 
monitor your speedy, perform data trending and create 
distributed control systems.

To download the latest version of savvy go to 
www.driveweb.com and click on Get savvy.

Java Runtime Environment must be installed to run 
savvy. There is  a link on the Get savvy page to 
download Java for free. 

If you do not have internet access,  install savvy and Java 
from the Bardac Infodisk. Browse to the savvy link, 
off-line installation. Contact us for the files or Infodisk.

drive.web automation
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Get started with savvy
We strongly recommend attending our free on-line training 
seminars. To register and get your invitation, call or e-mail 
training@driveweb.com.

Before proceeding with your systems designs it is very 
important to familiarize yourself with savvy, the 
configuration software. 

We strongly recommend you read the User Manual and 
Getting Started Guides under the Help menu.   

Use Create Phantom in the Directory menu to practice, 
explore all drive.web products and options and design and 
configure off-line. Design systems in Phantom devices and 
Export Data under the Directory menu for later use in 
live devices. Import Data into  phantoms to work off-line. 

The savvy window title bar indicates the current view.
The status bar above the viewing area provides object and 

location data and navigation arrows.
savvy views are hierarchical with the Directory view at top. 

Use the navigation arrows to view the next higher level or 
go backward and forward through views. Note that window 
menus change as you navigate. 

Hover mouse cursor over any active object, device, 
function block, connection or parameter icon to view object 
information in the status bar and reveal a hover-button.

Click a hover-button or right-click anywhere in an active 
object to access a contextual menu. See below.

savvy functionality may be limited if you do not have the 
required password-protected capability level (see File > 
Capability...) or a device is locked with a password (see 
contextual menu below).

Warning! Changing a device IP address WILL disrupt its 
network connections! If a speedy is communicating with 
other devices or drives you must be prepared for system 
disruption and to remap connections in those devices when 
changing an IP address. In the File menu choose Utility > 
Remap Export File to remap a dw-system file with 
different IP address(es).
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Get started with savvy continued...

Device Directory  window, select File > Administrate > Set 
IP Addresses for System.  The serial number marked on 
your speedy is its  MAC Address. Enter a unique IP 
address within your computer’s subnetwork, click OK.  

A speedy icon should appear with IP address beneath.

If the icon at right appears,  a network connection problem 
exists. Check connections, LEDs and that the speedy  IP 
address is within your computer’s Ethernet subnet mask.  

Device Directory window, select Directory menu.  

Discover All Local Devices.  When speedy is powered 
up and connected to the same local network as  your 
computer, an icon should appear. 

Discover Device... Anywhere on the internet via a public 
IP address, VPN or similar. 

Advanced Users: At the bottom of the Set IP 
Addresses window,  click the arrow next to 
Network Information to set subnet mask, 
router, SMTP mail server and SNTP time server 
IP addresses. See the savvy user manual. 
Note! If the Network Information box is 
expanded, this network information will be set in 
the device(s) whose IP address(es) are changed.

Warning! Importing a configuration into your speedy 
will result in immediate execution of that configuration. 
Dangerous Voltages and rotating  machinery may 
result!.Use a phantom to preview a configuration.

Directory > Import / Export Data. All device 
configurations and drive.web connections  between 
devices in the directory. 

speedy contextual menu (via right-click or hover-button)

Change Name. Name your speedy for easy identification. 

Import Device Data / Export Device Data... Load / 
save configuration data to / from this speedy only.

drive.web automation
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Get started with savvy - speedy contextual menu continued...

Find Parameter... Enter parameter number, name or 
partial name to view it.

Unlock, Lock, Set Password. The speedy at  right is 
locked to Restrict Modification. Viewing configuration 
is possible. The speedy below it is  locked to Restrict All 
Access. Select lock type when setting password.

Click the speedy icon to view the Device Overview 
screen (Standard savvy, no SFD). Click the 
Function Block Engine icon or, if you have options 
04 , 17 to 19, 25, the Comms Server icon to view. 

Function Block Engine Window. Select FBE menu 
(Standard savvy, no SFD), and add function blocks in 
the order to be processed. Processing  order is  from left to 
right, then top to bottom.

Click on function block to view parameters and function detail. 

Warning! Making a connection will result in immediate 
execution of that connection. Dangerous Voltages 
and rotating machinery may result!.

Connect between parameters and to parameters  in other 
drive.web devices over Ethernet. 

Under the File menu, choose New Viewer... and then 
Open Device Directory. With two viewer windows, 
click on a parameter,  drag  a connection and drop onto 
a destination parameter in the other viewer.   

Parameter contextual menus (via right-click or hover-button)

Most parameter data is  16-bit. Raw decimal integer values 
0 to 65535 or ±32767. Data is formatted, limited and 
scaled depending on the parameter.  Use Get Info or Re-
Scale... to verify or change.

Click parameters to open a setter box. Adjust value 
with convenient graphical buttons or keyboard entry. 
Also find buttons for return to default or last state.

Click blue connection block or arrow to jump to other end.
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Upgrade savvy and speedy
Upgrade savvy with SFD Signal Flow Diagram. 
Upgrade speedy with software options. 
Process credit cards or Vouchers on-line or Coupons off-line. 

To upgrade savvy go to the Commerce menu,  select 
Upgrade savvy, check the desired option and click OK.

To upgrade speedy,  right-click on the speedy icon, choose 
Upgrade Device…, check the desired option and click OK.

Your selected options  will appear in the Shopping Cart. Select 
your method of  payment.

To process  Vouchers, choose Pay>Online Via Vouchers in 
the Shopping Cart. Enter Voucher codes on separate lines.

To process  Coupons click Buy and forward the code to your 
drive.web distributor. When you receive your coupons  go to 
the Commerce menu and choose Coupon Manager. Enter 
codes in the top box and click the Add button. Click Apply.

savvy-SFD Signal Flow Diagram Upgrade
With savvy-SFD, build systems graphically while 

creating live drawings that are stored in your speedy.  
Set borders with user attributes,  drag and drop 

connections,  zoom,  pan, cross-reference and annotate 
multi-page drawings. 

Right-click in an empty area of the SFD to zoom,  add a 
new function block or note or to paste a parameter for 
convenient viewing.

A filterable list of function blocks and connections is  at 
the left of the Signal Flow Diagram showing 
program execution order from top down. The 
order in which function blocks are processed can 
greatly influence system performance and the 
function of logic engines. Change execution order by 
dragging  function blocks  up or down the list. In this 
picture, ENC1 Speed function block and its outgoing 
connection will be moved so that they are processed 
after ENC Phase Lock. 
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savvyPanel Operator Station
Computers, Apple® mobile digital devices;  iPad®, iPhone® & iPod Touch® 

are operator touch stations  with savvyPanel. Requires  Windows(XP, 
Vista, 7), Mac OSX, Linux(Solaris, Umbuntu, etc) or iOS.

Operator station data is located in the drive.web devices so setup is easy. 
Editing and building savvyPanel systems requires savvy SFD upgrade.
savvyPanel dwOption-26 must be installed in drive.web devices  to 

enable the full suite of  tiles. A limited set is available without the option. 
Find complete information on savvyPanel in the savvy User Manual.

Get savvyPanel Free from the Apple App Store℠
When your iPad or iPhone is  connected to the internet with WiFi you are 

connected live to a real drive system in our plant in Maryland, USA.
Touch Roll Change button to reset the roll length.
Enable all section switches; extruder, brake, winder
Touch the Line Start button and watch the line 

accelerate,  run and then automatically slow to 
stop at the required length.

Touch Set Speed, Set Temp or Set Tension to 
open the setter and make changes.

Touch the parameter name in the setter to get info
Touch page-link arrows to browse demo pages.
Drive the demo with savvy in your computer. In 

the File menu > Demo Mode,  choose Discover 
Internet Demo Devices.

Three savvyPanel Page Types
Systems Page present with multiple savvyPanel systems discovered. 

A savvyPanel system may contain tiles from many devices. 
A drive.web device may contribute to only one savvyPanel system.
Touch the systems  button,      or     ,  in the window bar to access  the 

systems page from home page. Lock this button with home password.
Home Page is the first operator page in a savvyPanel System.

Access  home page from any operator page with the home button,       . 
This may be locked with the home password.

Operator Pages show graphic, page-link and parameter tiles. 
Pages can be renamed. The name appears in the window title bar.
View zooms to show all tiles, so layout strongly affects appearance.
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Three savvyPanel Tile Types

Parameter Tiles. Touch a settable parameter to 
see its  savvyPanel setter. Includes;  slider, 
keypad, 1x, 10x increment, default & revert. 

A parameter is  settable if it  is not  read-only and 
has no incoming drive.web connection.

Meter tiles;  digital panel meter,  dial or bar 
meter. Unipolar or bipolar. Full-scale or percentage.

Indicator tiles. Variety of  colors. Shows on/off, true/false state.

Pushbutton tiles; colored momentary and lighted Start/Stop.

Multi-position Switch tiles for enumerated parameters.

Graphic Tiles - create diagrams with a variety of  process elements.

Page-Link Tiles - A graphic tile that is also a touch page-link. 

Function Blocks Enable savvyPanel Actions

Enumerated Parameter block in Utility group. Only custom 
enumerations appear in the setter and multi-position switch.

In the savvyPanel function block group:

Latch and SR Latch support lighted start-stop pushbuttons. 

Setpoint & Monitor blocks  control meter range. Setpoint 
clamps setter. Dual blocks enable dual display meters

savvyPanel Launch, Setup and Important Notes

See the savvy User manual for detailed instructions.

Launch savvyPanel from a command line or batch file. 

Limit operators to savvyPanel-only, specify start system & page.

Discover devices  specifically by discovery file, automatically or 
filtered by group and/or savvyPanel name.

Operator’s  Note: If communication with a drive.web device is 
interrupted,  affected tiles  indicate a yellow bar at top with an 
exclamation warning. The displayed value is not updated.

Important  Design Note: An over-range enumeration is  required if 
misreading an out-of-range value could cause a hazard.
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speedy Comms Interfaces-Modbus & EIP/PCCC
Warning! Use of speedy comms interfaces, ModbusTCP, 
ModbusRTU and EIP/PCCC, may cause motors and machinery to 
power up with high Voltages or start or operate in an unexpected, 
dangerous or lethal way. It is essential that you are completely familiar 
with the Ethernet server protocol and all of the equipment and the 
system design you are working with before attempting to use this 
option. It is also essential that a risk assessment is conducted to identify 
hazards. Risks must be reduced to tolerable levels.

For info on Modbus specifications go to http://modbus.org/specs.php

Boolean values are 0 or 1. Non-zero values are Boolean true. 

speedy Ethernet Server Support, Options 04 & 25
Click the Comms Server icon in the 

FBE or SFD view to configure.

Comms Server Indirect parameters are 
sequentially numbered. Enter any 
parameter numbers to read or write 
them all with one operation. Add more 
with Comms Server Indirect function 
blocks in the Utility list  set. You can 
directly address any parameter. You are 
NOT required to use them.

Comms Watchdog function block,  available in the Utility 
function block list group, can only be written via Modbus 
comms. Write non-zero value to Input to keep Output = OK

Note! You cannot write or force parameters  that are read-only 
or have incoming drive.web connections.

speedy Option 04 ModbusTCP/IP Slave/Server

Standard option, included.

ModbusTCP Slave Port 502 is  standard specified in protocol. 
Change it in the unusual case that the master is non-standard.

Modbus Function Codes FC 01-06, 15 and 16 are supported.

Supports up to five simultaneous clients/masters. 
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speedy Option 25 EIP/PCCC Server
Supports EIP/PCCC Typed-Write and Typed-Read functions.

See Appendix B  of savvy User Manual for information, 
examples and drive.web to PLC parameter mapping.

Supports up to two simultaneous clients. 

ModbusRTU Master & bus-share drive interface
Adding network devices may affect dedicated drive’s serial link performance.

Modbus  Function Codes FC 01-06 and 16 are supported. Also 
Yaskawa Holding Register function.

Note: Modbus address 1  is  the dedicated drive’s  address  for 
dw222, dw223 and dw226. dw225’s dedicated drive is 
address  0x1F or 31. Bus-sharing Modbus servers  must use 
different addresses. 

Comms Port function block
Comms Speed Read-only for drive-dedicated 

speedy’s. dw220,  choose standard 
speeds are enter baud rate 0.1 to 500Kbps. 

Comms Configuration Read-only in 
dedicated speedy’s. 

	 Character frame is 1-8-Parity-Stop:
Parity is  N None, O Odd,  E Even, 

S Space(0) or M Mark(1).

Number of  Stop bits; 1, 1.5 or 2.

Minimum Comms Silence. Idle on-the-wire time before a new 
request is  sent. Some devices require longer than minimum 3.5 
characters. Longer times decrease comms efficiency.

Bandwidth. Drive-dedicated models  only. The portion of the 
bandwidth allocated for all Modbus Data blocks.

Actual Polling Period. Read-Only. Time required to poll all 
parameters in all Modbus  Data blocks  with that priority. 
Period is directly affected by number of parameters,  silence 
times and any errors or timeouts.

Comms Timeout. 10 to 30000ms  waits  for a reply. Status 
indicates Timeout if  no reply is received.
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ModbusRTU Master - Comms Port function block continued..
Status. Any Last Error in Modbus Data blocks. Click to Reset all. 
Enable. Globally enable and disable all Modbus Data blocks. 

Modbus Data blocks, Boolean, INT16, UINT16
Define the data point,  register, discrete or coil and 

the slave or server device. Create up to 32 data 
blocks. Addresses can be changed dynamically.

Boolean block’s Value can be True(1) or False(0). 
INT16, 16-bit Integer, Value is ±32767. 
UINT16, Unsigned 16-bit Integer, Value, 0 to 65535.
Modbus Address. Unique address,  1 to 247 of 

individual server device. 
PDU Address identifies the parameter, coil, discrete or register 

number in your server to read and/or write to/from.  
Enable Dynamically disable block when unneeded to reduce 

polling periods. 
Last Error enumerates last error detected. Click to Reset.
Modbus Type. ModbusRTU function supported by your server. 
Priority  Three levels. Round-robin scheduler processes all High 

priority data blocks  plus one other every round. All Medium 
priority blocks  are processed, one per round, then first Low 
priority block. Following rounds  process  all Medium priority 
blocks again then next Low priority.

Value. Raw decimal read/written to/from the remote parameter.

speedy Option 06 Winder Control Library
Accurate speed calibration of all components  in a winder system is 
essential before commissioning.

Diameter Calculator Block. An instance of this block is 
required for Taper Tension and Torque Compensator 
blocks. Associate a Diameter Calculator in those blocks. 

Taper Tension Function Block. A positive setpoint reduces 
web tension as the roll diameter increases. 

Torque Compensator Block. Set Forward/Reverse Line 
Direction friction compensation,  Unwind/Rewind and Wind 
Forward/Wind Reverse modes. Friction and Inertia 
Compensator buttons set Stiction, Static Friction & more. 
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Type to enter text

Device Group
savvyPanel System
Example

Discover devices when savvy 

launches or by using the 
Directory menu. Discover by;  
group, savvyPanel system, 
Discovery file or all local devices 
automatically or by request.

Device Directory

Function Block Engine Standard savvy savvy-SFD

With standard savvy, the device 
overview screen gives access to 
Comms Server setup, Function 
Block Engine and native device 
functions where applicable. 
With savvy-SFD place function 
blocks graphically, use function 
block list to review and arrange 
execution order.

Function Block
View functional elements and 
signal paths in relation to 
parameters. Parameters show 
type, drive.web connections, 
read-only and not at default 
adornments.  

Add parameters of  interest to set, 
view, create trend graphs and 
export .csv files for spreadsheets. 
Save docks and open multiple 
docks in different viewer 
windows.

Parameter Dock

savvy overview

Right-click on parameter,
“Copy Parameter”

Navigate 
Up 

Arrow

Device 
Name

Right-click on parameter
“Add to Parameter Dock” 

Dock menu > Show Trend

Touch or Click

Touch or Click

.. ·-. . . . ...... "' . 

llO \Yater Air Qual. &'8.fta~ce 
I • • • • • • . . . . . . . . . ,

# 

~ I .. 
~~--~ •: ., 

• 
' : A 1 Extruder b tl'ude, .. .1in1gie:ent 

~~ - -------------. . . 

t ,·--
I ,.__,._,.,_._ c, I 

• r:--==-

. . ... . 
Press Ops • . . ..... .. . 

. . 
I 

Unwind/Re Ind 
, . 
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Systems Page

savvyPanel

Systems

savvyPanel Password is not 
set in savvyPanel operator 
station. No savvyPanel

data is shown.

savvyPanel overview

View all available 
savvyPanel systems. Assign 
a savvyPanel system in 
each device’s contextual 
menu, one per device. If  a 
savvyPanel password is set 
in the device, it must also be 
added in savvyPanel

operator station software 
under the savvyPanel menu

Home Page
The master page for a 
savvyPanel system. Similar 
to operator pages except that 
it may be accessed from any 
operator page by pressing the 
home button. Graphic tiles 
can be page links.

Up to 256 possible. May be 
page-linked in any way. Set 
savvy preferences so that 
operators view a specific page 
at launch. Use this preference 
and the home password to 
restrict access to the home 
page and pages linked only 
from the home page. Provide 
links to the home page to 
bypass the home password. 
home password then only 
restricts access to the systems 
page.

Operator Pages

?
Systems Button. 
Requires Home Password if  set.

Touch or Click 
Page-Link

Home Button. 
Requires Home Password if  set.

Right-click in an empty 
grid location and, 
“Paste Parameter”. 
Choose desired graphic.

Touch or Click

?

• • • • • • • • • e nvironment~! EJttrudus West Hi• Spetd Prus . . . . . . . . . . . ......... ;. • ......• 
I I Ll {il:_!J ~--• • • • • • • • • • • • • • • • • •- I l X I 

I- System OK ......... - Speed Set point 

85.44 " 

Melt Temp. 

Home 



drive.web product line highlights
Drive-dedicated smarty and speedy models are 

available with complete, one-cable drive interfaces. 

Peer-to-peer drive.web connections over Ethernet 
enable distributed control and open scalability.

smarty     DIN rail drive.web controller.  
Sixteen flexible, bipolar-analog / digital I/O
Hardware options;  dual serial-ports,  add six 

digital inputs, frequency I/O,  relay-rack 
control, remote module comms.

External options;  dual encoder module with re-
transmit, high-Voltage I/O.

Encoder control library with cyclic and linear 
positioning and electronic line shaft support

savvy-SFD Signal Flow Diagram upgrade, see page 13.
savvyPanel operator touch station app, see pages 14 to 17.
All drive.web products are designed & assembled in the U.S.A.
Get expert drive.web help. Call or email techsupport@driveweb.com

drive.web training courses 
Free!online interactive training seminars take about one hour. 
Specialized online and factory training sessions are also available. 
To register email training@driveweb.com or call.
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Supported Drive smarty  Model speedy  Model

Generic dw210 dw220

PL/X Digital DC Drive dw211 dw221

Optidrive P2 dw214 dw224

Optidrive Plus dw213 dw223

Optidrive HVAC dw216 dw226

Optidrive E2 dw212 dw222

Optidrive E2 Single Phase Output dw212 dw222

YaskawaF7 dw215 dw225

drive.web 40 Log Canoe Circle, Stevensville, MD 21666 USA. 
Ph. 410-604-3400, Fax 410-604-3500, www.driveweb.com

®

Drives and Automation 
Call 800-848-2504 
www.emainc.net 


